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ABSTRACT 
 

          Our project integrates a Solar Tracking System (STS) with IoT-based Battery Monitoring using 

Arduino and ESP8266, leveraging the ThingSpeak IoT platform. The STS optimizes solar panel orientation 

by tracking the sun's position throughout the day, managed by Arduino Uno with light sensors and servo 

motors for precise alignment. Augmented with IoT-based Battery Monitoring, the system ensures enhanced 

reliability and remote management. ESP8266 facilitates wireless communication, transmitting real-time 

battery data to ThingSpeak's cloud platform. Users can monitor battery health, charge levels, and receive 

alerts for maintenance needs. This integration empowers users to remotely optimize system performance 

and ensure uninterrupted energy supply. ThingSpeak's intuitive interface allows easy access to vital system 

metrics, facilitating efficient energy management. This research introduces a smart automation solution 

employing a two-channel relay, controllable via the Blynk mobile app, facilitating remote operation and 

automation of electrical devices for enhanced convenience and energy efficiency in modern living spaces. 

 

INTRODUCTION 

 

In an era marked by increasing environmental concerns and the quest for sustainable energy sources, solar power 

has emerged as a beacon of hope. Its abundance and renewability offer a promising alternative to traditional fossil 

fuels, yet harnessing solar energy efficiently remains a challenge. The dynamic nature of sunlight and the need for 

effective energy storage solutions call for innovative approaches that maximize energy capture while ensuring 

system reliability and longevity. In response to these challenges, our project focuses on the integration of two 

cutting-edge technologies: Solar Tracking Systems (STS) and IoT-based Battery Monitoring, leveraging ESP8266 
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modules and orchestrated through the powerful ThingSpeak IoT platform.Solar energy's ascent to prominence as a 

viable alternative to conventional energy sources is undeniable. However, the optimal utilization of this abundant 

resource hinges on addressing key challenges such as maximizing energy capture and ensuring effective battery 

management. The integration of Solar Tracking Systems with IoT-based Battery Monitoring represents a 

transformative approach to addressing these challenges comprehensively. Solar Tracking Systems dynamically 

adjust the orientation of solar panels to align with the sun's position throughout the day, optimizing energy capture. 

By implementing a Solar Tracking System powered by Arduino, equipped with light sensors and servo motors, our 

project ensures real-time adjustments to panel angles, maximizing solar energy yield. Furthermore, ensuring the 

reliability and efficiency of solar energy systems necessitates robust battery management. Here, IoT-based Battery 

Monitoring plays a pivotal role, leveraging ESP8266 modules to wirelessly transmit crucial battery health and 

charge status data to the cloud. Leveraging the capabilities of the ThingSpeak platform, users gain remote access 

to this data, enabling proactive maintenance and troubleshooting while receiving timely alerts for any potential 

issues. The integration of solar tracking and IoT-based battery monitoring signifies a significant advancement in 

sustainable energy management. By seamlessly combining these technologies, our project aims to demonstrate how 

leveraging the ThingSpeak platform can enhance the efficiency, reliability, and accessibility of solar energy 

systems, contributing to a greener and more sustainable future. In the following sections, we will delve into the 

technical intricacies of our project, detailing the implementation of Solar Tracking Systems, IoT-based Battery 

Monitoring, and the integration with the ThingSpeak IoT platform. Furthermore, we will explore the potential 

benefits of this integration in advancing sustainable energy solutions and mitigating the environmental impact of 

energy consumption. With the rapid advancement of technology, smart automation systems have become 

increasingly prevalent in various aspects of our daily lives. One such application is the use of IoT (Internet of 

Things) devices to control and monitor electronic appliances remotely. In this project, we focus on the development 

of a smart automation system using a 2-channel relay controlled through the Blynk mobile application. The Blynk 

app provides a user-friendly interface for controlling IoT devices over the internet, making it an ideal platform for 

implementing home automation solutions. By integrating Blynk with a 2-channel relay module, users can remotely 

switch on or off electrical appliances such as lights, fans, or other devices connected to the relay. In this introduction, 

we will provide an overview of the project objectives, the components used, and the expected benefits of 

implementing this smart automation system. Additionally, we will outline the structure of the following sections, 

which will delve into the details of the project implementation and functionality. 

 

1.1  EMBEDDED SYSTEMS 

 

Embedded systems play a crucial role in the implementation of Solar Tracking and IoT Battery Monitoring in 

conjunction with ESP8266 modules on the ThingSpeak platform. These systems are responsible for the seamless 

integration of hardware components, data processing, communication, and control functionalities. In the context of 

our project, embedded systems facilitate the following key aspects: 
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1. Hardware Integration: Embedded systems, typically based on microcontrollers like Arduino Uno, serve as the 

central processing units that interface with various hardware components. For solar tracking, embedded systems 

control servo motors to adjust panel angles based on real-time sensor data. Similarly, for IoT-based battery 

monitoring, they interface with battery sensors and ESP8266 modules to collect and transmit battery-related data 

to the cloud. 

 

2. Real-time Control and Decision Making: Embedded systems execute control algorithms for solar tracking, 

continuously adjusting panel angles to maximize energy capture based on sensor inputs. These systems perform 

real-time calculations to determine optimal panel orientations relative to the sun's position. Additionally, they 

implement logic for battery monitoring, such as voltage and temperature thresholds, to trigger alerts or adjust system 

parameters as necessary. 

 

3. Data Processing and Communication: Embedded systems process sensor data and format it for transmission 

to the ThingSpeak cloud platform via ESP8266 modules. They handle communication protocols such as Wi-Fi to 

establish connectivity with ThingSpeak servers, ensuring seamless data transmission and synchronization with the 

cloud. Furthermore, these systems may preprocess data locally to reduce bandwidth requirements or perform basic 

analytics before uploading to the cloud. 

 

4. Remote Monitoring and Control: Embedded systems enable remote monitoring and control of the solar 

tracking and battery monitoring systems through ThingSpeak's web interface or mobile applications. Users can 

access real-time data, receive alerts, and adjust system parameters remotely, enhancing system accessibility and 

enabling proactive maintenance. 

 

Overall, embedded systems serve as the backbone of the Solar Tracking and IoT Battery Monitoring solution, 

providing the intelligence and control necessary to optimize energy capture, ensure system reliability, and enable 

remote management via the ThingSpeak platform. Through the seamless integration of hardware and software 

components, embedded systems play a vital role in advancing sustainable energy solutions. 

 

1.2  APPLICATION AREAS 

 

The integration of Solar Tracking and IoT Battery Monitoring with ESP8266 modules on the ThingSpeak platform 

opens up a wide range of application areas where these technologies can be deployed effectively. Some key 

application areas include: 

 

1. Residential Solar Power Systems: Homeowners can utilize solar tracking systems coupled with IoT-based 
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battery monitoring to optimize energy production and storage. By tracking the sun's movement and monitoring 

battery health remotely, homeowners can maximize energy self-sufficiency, reduce electricity bills, and contribute 

to a greener environment. 

 

2. Commercial and Industrial Facilities: Businesses and industrial facilities can deploy solar tracking systems 

integrated with IoT-based battery monitoring to reduce energy costs and enhance sustainability. These systems can 

be scaled up to meet higher energy demands, providing reliable power for manufacturing processes, office 

buildings, warehouses, and more. 

 

3. Off-Grid Applications: Solar tracking and IoT battery monitoring are particularly valuable in off-grid or remote 

locations where access to traditional power sources is limited. Applications such as off-grid cabins, remote 

monitoring stations, telecommunications infrastructure, and agricultural operations can benefit from reliable solar 

energy generation and battery storage, coupled with remote monitoring capabilities. 

 

4. Smart Agriculture: Solar-powered IoT systems can be deployed in agriculture for various purposes, including 

irrigation control, environmental monitoring, and precision agriculture. Solar tracking enables efficient energy 

capture for powering sensors and actuators in the field, while IoT-based battery monitoring ensures continuous 

operation and data collection. 

 

5. Environmental Monitoring and Research: Solar-powered IoT systems can be used for environmental 

monitoring and research applications, such as weather stations, air quality monitoring, and wildlife tracking. Solar 

tracking ensures optimal energy capture for powering sensors and transmitting data, while IoT-based battery 

monitoring ensures uninterrupted operation in remote or harsh environments. 

 

 

6. Emergency Response and Disaster Management: Solar-powered IoT systems can serve as resilient 

communication and monitoring platforms in emergency response and disaster management scenarios. These 

systems can be deployed quickly in affected areas to provide power, communication, and situational awareness, 

facilitating coordinated response efforts and improving disaster resilience. 

 

7. Education and Research: Solar tracking and IoT battery monitoring systems provide valuable educational 

opportunities for students and researchers to learn about renewable energy, electronics, data analytics, and IoT 

technologies. These systems can be used in educational institutions and research laboratories for hands-on learning 

and experimentation. 
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Overall, the application areas for Solar Tracking and IoT Battery Monitoring with ESP8266 modules are diverse 

and encompass a wide range of industries and use cases. By leveraging these technologies, organizations and 

individuals can achieve greater energy efficiency, reliability, and sustainability in various domains. 

 

1.3  Over view of Embedded system Architecture 

 

The embedded system architecture for Solar Tracking and IoT Battery Monitoring with ESP8266 modules 

encompasses hardware components, software algorithms, communication protocols, and cloud integration. Here's 

an overview of the architecture: 

 

1. Hardware Components: 

 Microcontroller (e.g., Arduino Uno): Acts as the central processing unit and interfaces with sensors, 

actuators, and ESP8266 modules. 

 Sensors: Light sensors for solar tracking, battery sensors for monitoring voltage, current, and temperature. 

 Actuators: Servo motors for adjusting solar panel angles. 

 ESP8266 Module: Enables Wi-Fi connectivity for communication with the ThingSpeak cloud platform. 

 

2. Software Algorithms: 

 Solar Tracking Algorithm: Determines optimal solar panel orientation based on real-time input from light 

sensors and the sun's position. 

 Battery Monitoring Algorithm: Monitors battery health and charge status, triggers alerts for low voltage or 

critical conditions. 

 Communication Protocol: Implements protocols such as Wi-Fi (for ESP8266 communication) and 

HTTP/HTTPS (for cloud communication) to transmit data. 

 

3. Communication and Connectivity: 

 Local Communication: Microcontroller communicates with sensors, actuators, and ESP8266 module using 

standard communication interfaces such as I2C, SPI, or UART. 

 Wireless Communication: ESP8266 module establishes Wi-Fi connectivity to transmit data to the 

ThingSpeak cloud platform. 

 Cloud Integration: Data is transmitted securely to the ThingSpeak cloud platform using HTTP/HTTPS 

protocols, where it is stored, processed, and made accessible for remote monitoring and analysis. 

 

4. Cloud Platform (ThingSpeak): 

 Data Storage: ThingSpeak stores sensor data in channels, allowing for easy retrieval and analysis. 

 Visualization: Provides customizable charts, graphs, and dashboards to visualize real-time and historical 

data. 

 Alerts and Notifications: Allows users to set up alerts based on predefined thresholds for battery voltage, 
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solar panel efficiency, or other parameters. 

 Remote Access: Users can remotely monitor system status, adjust settings, and receive notifications via 

web interface or mobile applications. 

 

5. User Interface: 

 Web Interface: ThingSpeak provides a user-friendly web interface for accessing and managing data, setting 

up alerts, and visualizing system performance. 

 Mobile Applications: ThingSpeak offers mobile applications for iOS and Android devices, allowing users 

to monitor and control the system remotely. 

   1.4 Embedded Block Diagram 

 

 

                  Circuit Diagram Solar Tracking System (STS) using Arduino 
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               Circuit Diagram IoT-based Battery Monitoring using ESP8266 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.4  Application of Embedded System 

 

1. Home Solar Energy Systems: 

 Powering homes with solar energy while efficiently tracking the sun's movement for optimal energy 

capture. 

 Monitoring battery health and charge status to ensure uninterrupted power supply, reducing reliance on the 

grid. 

 

2. Smartphone Charging Stations: 

 Setting up solar-powered charging stations for smartphones and other portable devices in parks, public 

spaces, or outdoor events. 

 Using IoT battery monitoring to manage charging cycles and ensure availability of charged devices. 

 

3. Outdoor Lighting Solutions: 

 Illuminating pathways, gardens, and outdoor spaces with solar-powered lights that adjust brightness based 

on available sunlight. 

 Monitoring battery levels to ensure continuous lighting throughout the night, enhancing safety and security. 

 

4. Solar-Powered Garden Accessories: 

 Installing solar-powered water features, garden lights, and decorative accessories that automatically adjust 

to capture sunlight efficiently. 

 Monitoring battery status to ensure optimal performance and longevity of garden accessories. 

 

5. Portable Solar Chargers: 
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 Using portable solar chargers equipped with IoT battery monitoring for charging smartphones, tablets, and 

other electronic devices while on the go. 

 Monitoring battery levels and charging status to optimize device charging and extend battery lifespan. 

 

6. Outdoor Recreational Equipment: 

 Incorporating solar-powered features into outdoor recreational equipment such as backpacks, tents, and 

camping gear. 

 Monitoring battery levels to ensure reliable performance of equipment during outdoor activities and 

adventures. 

 

7. Smart Home Automation: 

 Integrating solar tracking and IoT battery monitoring into smart home automation systems to optimize 

energy usage and reduce utility costs. 

 Controlling home appliances, lighting, and climate control systems based on real-time energy availability 

and battery status. 

 

8. Solar-Powered Wearable Technology: 

 Developing wearable devices, such as smartwatches and fitness trackers, with integrated solar panels for 

continuous charging. 

 Utilizing IoT battery monitoring to optimize power consumption and manage charging cycles for wearable 

technology. 

 

1.5 Characteristics 

 

 1. Efficiency Optimization: 

 Solar tracking adjusts panel angles to maximize energy capture from sunlight throughout the day. 

 IoT battery monitoring ensures efficient use of stored energy, prolonging battery life and optimizing power 

usage. 

 

2. Remote Monitoring and Control: 

 ESP8266 modules enable wireless communication, allowing users to monitor and control solar tracking 

and battery systems remotely. 

 Users can access real-time data, receive alerts, and adjust system settings via web interfaces or mobile 

applications. 

 

3. Reliability and Resilience: 
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 Solar tracking and IoT battery monitoring enhance system reliability by ensuring continuous power supply 

and proactive maintenance. 

 These systems provide resilience against grid outages, enabling uninterrupted operation in off-grid or 

remote locations. 

 

4. Data-driven Insights: 

 Solar tracking and IoT battery monitoring collect and analyze data on energy production, consumption, 

and battery health. 

 Users gain valuable insights into system performance, enabling informed decision-making and 

optimization of energy resources. 

 

5. Scalability and Flexibility: 

 Solar tracking and IoT battery monitoring solutions can be scaled up or down to meet varying energy 

demands and system requirements. 

 They offer flexibility in deployment across different applications, from residential homes to commercial 

facilities and off-grid installations. 

 

6. Integration with IoT Ecosystem: 

 ESP8266 modules seamlessly integrate solar tracking and battery monitoring systems into the broader IoT 

ecosystem. 

 They enable interoperability with other IoT devices and platforms, facilitating data sharing, analytics, and 

automation. 

 

These characteristics underscore the versatility, efficiency, and reliability of Solar Tracking and IoT Battery 

Monitoring with ESP8266 modules, making them essential components of modern energy management systems. 
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CHAPTER 2: LITERATURE SURVEY 

2.1 Literature Survey 

A literature survey on Solar Tracking and IoT Battery Monitoring with ESP8266 encompasses a comprehensive 

review of existing research, studies, and projects in the field. Solar tracking systems, aimed at maximizing energy 

capture by aligning solar panels with the sun's position, are explored along with IoT-based battery monitoring 

systems, which facilitate real-time monitoring of battery health and performance. These systems are crucial for 

enhancing the efficiency and reliability of solar energy systems. The survey delves into various solar tracking 

techniques, including single-axis and dual-axis tracking, evaluating their accuracy, complexity, and cost-

effectiveness. Similarly, IoT-based battery monitoring systems are examined, focusing on sensor technologies, 

communication protocols, and data analytics methods used for battery health monitoring. Integration of ESP8266 

modules, renowned for their wireless communication capabilities, with the ThingSpeak IoT platform is highlighted 

as a pivotal aspect of system implementation, enabling remote access, data storage, and visualization. Case studies 

showcasing real-world applications of Solar Tracking and IoT Battery Monitoring systems in residential, 

commercial, and industrial settings provide insights into system deployment and performance. The survey 

concludes with discussions on challenges such as system complexity and scalability, as well as future research 

directions to further advance the field. Through this literature survey, researchers can gain a comprehensive 

understanding of the current state of the art and identify avenues for future research and innovation in Solar Tracking 

and IoT Battery Monitoring with ESP8266. 

 

2.2 Existing System 

The existing system for Solar Tracking and IoT Battery Monitoring with ESP8266 involves a combination of 

traditional solar tracking mechanisms and standalone battery monitoring systems. Typically, solar tracking systems 

utilize sensors to detect sunlight intensity and adjust solar panel angles accordingly, optimizing energy capture 

throughout the day. These systems may operate independently of battery monitoring, relying on manual or periodic 

checks to ensure battery health and performance.Similarly, standalone battery monitoring systems utilize sensors 

to measure parameters such as voltage, current, and temperature, providing insights into battery health and charge 

status. However, these systems may lack integration with solar tracking mechanisms, limiting their ability to 

optimize energy usage and battery performance in real time. While both solar tracking and battery monitoring 

systems serve essential functions in maximizing energy efficiency and system reliability, the lack of integration can 

result in suboptimal performance and increased maintenance efforts. Users may need to manually adjust solar panel 

angles based on weather conditions or battery status, leading to potential energy wastage or downtime. Overall, the 

existing system comprises separate components for solar tracking and battery monitoring, with limited integration 

and automation capabilities. There is a need for a more cohesive and integrated solution that combines solar tracking 

and battery monitoring functionalities, leveraging ESP8266 modules and IoT technologies for seamless 

communication, remote monitoring, and intelligent control. 
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CHAPTER 3: IMPLEMENTATION 

3.1 Proposed System 

The proposed system for Solar Tracking and IoT Battery Monitoring with ESP8266 presents a comprehensive and 

integrated approach aimed at overcoming the limitations observed in existing systems. At its core, this system 

combines the functionalities of solar tracking technology and IoT-based battery monitoring, harmonizing them 

through the utilization of ESP8266 modules, renowned for their capabilities in facilitating seamless communication 

and control. The solar tracking component of the system operates dynamically, continuously adjusting the angles 

of solar panels to optimize energy capture by aligning them with the sun's position throughout the day. This process 

is facilitated by sophisticated algorithms that account for various environmental factors such as the sun's trajectory, 

weather conditions, and potential shading. Concurrently, the IoT-based battery monitoring aspect ensures the real-

time monitoring of crucial battery health and performance parameters. These parameters include voltage, current, 

temperature, and other relevant metrics. This data is then wirelessly transmitted to the cloud infrastructure via 

ESP8266 modules, enabling remote access, analysis, and visualization. Integral to the system's functionality is its 

integration with the ThingSpeak IoT platform. This platform serves as the backbone for data storage, visualization, 

and remote management. It facilitates the seamless transmission and storage of solar tracking and battery 

monitoring data, while also providing a user-friendly interface for accessing system metrics, trends, and alerts. 

Moreover, the proposed system boasts sophisticated automatic control algorithms, which optimize energy 

consumption and battery charging cycles in real time. This ensures not only maximum energy efficiency but also 

extends the longevity of the battery system. Ultimately, the user-friendly interface empowers users to effortlessly 

manage the system, whether through web browsers or mobile applications. Visualization tools within the interface 

provide insightful analytics on energy production, consumption patterns, and battery health trends. In summary, the 

proposed system stands as a testament to the evolution of solar energy management, offering a comprehensive, 

intelligent, and user-centric solution that enhances efficiency, reliability, and sustainability across diverse 

applications and settings. 

3.2 Objective of the Proposed System 

The primary objective of the proposed system for Solar Tracking and IoT Battery Monitoring with ESP8266 is to 

develop a cohesive and integrated solution that addresses key challenges in solar energy management. At its core, 

the system aims to optimize energy capture from solar panels by dynamically adjusting their angles to align with 

the sun's position throughout the day. This optimization is facilitated through the implementation of advanced solar 

tracking algorithms, which seek to maximize energy production while minimizing wastage. Additionally, the 

system endeavors to continuously monitor the health and performance of the battery system using IoT-based 

sensors. By measuring parameters such as voltage, current, and temperature in real-time, the system can assess 

battery condition, detect anomalies, and ensure optimal operation. Moreover, the integration of ESP8266 modules 

and the ThingSpeak IoT platform enables remote monitoring and control capabilities, allowing users to access 

system data, receive alerts for critical events, and adjust settings from anywhere via web interfaces or mobile 

applications. This remote accessibility enhances convenience and enables proactive maintenance, ultimately 

contributing to increased system reliability and sustainability. Lastly, the system prioritizes user experience by 
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providing a user-friendly interface for system management, complete with visualization tools and intuitive controls, 

empowering users to monitor performance, analyze data trends, and make informed decisions effectively. Overall, 

the objective of the proposed system is to create a robust, efficient, and user-centric solution for optimized solar 

energy management. 

3.2.2 Block Diagram 
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3.3 Methodology 

The methodology for implementing the proposed system of Solar Tracking and IoT Battery Monitoring with 

ESP8266 follows a systematic approach to ensure successful development, integration, and deployment. Initially, 

a comprehensive analysis of system requirements is conducted, considering factors such as energy production goals, 

site conditions, and user preferences. This analysis guides the selection of appropriate hardware components, 

including solar panels, sensors, and ESP8266 modules, and informs the design of the overall system architecture. 

Software development involves the creation of algorithms for solar tracking, IoT-based battery monitoring, and 

user interfaces for remote monitoring and control. Integration of hardware and software components is followed by 

rigorous testing to validate system functionality and performance under various conditions. Upon deployment, 

optimization efforts focus on maximizing energy efficiency and reliability through parameter tuning and user 

training. Continuous monitoring and maintenance procedures are established to ensure long-term system reliability, 

with ongoing evaluation and feedback informing iterative improvements and enhancements. Through this 

methodology, the proposed system aims to deliver efficient, reliable, and user-friendly solar energy management 

capabilities for various applications and environments. 

3.4 Web Monitoring 

Web monitoring encompasses the systematic tracking and analysis of website performance, availability, and 

functionality to ensure optimal user experience and maintain the overall health of online platforms. This process 

involves defining clear objectives for monitoring, such as uptime, response time, and user interactions, and selecting 

appropriate tools and technologies to collect and analyze relevant data. Monitoring agents or probes are deployed 

strategically to simulate user interactions, monitor server performance, and gather data on website availability and 

response times. The collected data is then analyzed to identify trends, patterns, and anomalies, with a focus on key 

performance indicators like page load times, server response times, and error rates. Alerting mechanisms are 

configured to notify stakeholders of any detected issues or performance degradation, enabling timely response and 

resolution. Additionally, web monitoring facilitates performance optimization efforts by providing insights into 

areas for improvement, such as code optimization, server configuration, and content delivery network optimization. 

Continuous monitoring and iterative improvement processes ensure that websites and web applications consistently 

deliver optimal performance and user satisfaction over time. Through effective web monitoring practices, 

organizations can proactively identify and address issues, ultimately enhancing the overall user experience and 

maximizing the value of their online presence. 

3.5 Requirements 

The requirements for Solar Tracking and IoT Battery Monitoring with ESP8266 encompass a multifaceted approach 

to ensuring the system's functionality, performance, and user experience. Central to these requirements is the need 

for accurate solar tracking functionality, achieved through the implementation of precise algorithms that 

dynamically adjust solar panel angles in response to the sun's position. Concurrently, IoT-based battery monitoring 

must be seamlessly integrated, employing sensors to monitor critical parameters like voltage and temperature in 

real-time, while enabling wireless communication with ESP8266 modules for data transmission. Integration with 

cloud platforms such as ThingSpeak is essential, facilitating remote access, data storage, and visualization for users 
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via intuitive interfaces accessible from web browsers or mobile devices. Reliability and robustness are paramount, 

necessitating error handling mechanisms and rigorous testing to ensure system stability under varying 

environmental conditions. Additionally, scalability and flexibility are crucial, allowing for system expansion and 

compatibility with diverse battery and solar panel configurations. Energy efficiency optimization further enhances 

system performance, minimizing power consumption while maximizing energy capture and battery lifespan. By 

addressing these requirements comprehensively, the Solar Tracking and IoT Battery Monitoring system with 

ESP8266 can deliver efficient, reliable, and user-centric energy management solutions across a range of 

applications and settings. 
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CHAPTER 4: HARDWARE TOOLS 

4.1 Ardunio UNO    

 

 

 

 

 

 

 

 

 

The Arduino Uno microcontroller board stands as a pivotal component in the implementation of Solar Tracking 

and IoT Battery Monitoring systems with ESP8266, offering a versatile and user-friendly platform for developing 

and controlling intricate electronics projects. Equipped with an Atmega328P microcontroller, the Arduino Uno 

serves as the central processing unit, orchestrating the interactions between various hardware components. Its 

abundant digital and analog input/output pins facilitate seamless interfacing with a diverse array of sensors, 

including those essential for solar tracking and battery monitoring. Additionally, the Arduino Uno's capability to 

generate pulse width modulation (PWM) signals enables precise control over servo motors, facilitating accurate 

adjustments to solar panel angles for optimal alignment with the sun. Furthermore, the Arduino Uno communicates 

effortlessly with ESP8266 modules through serial communication protocols, allowing for wireless transmission of 

sensor data to cloud platforms or remote servers. This communication facilitates real-time monitoring and analysis 

of critical parameters, ensuring the system's efficiency and reliability. Programmed using the Arduino Integrated 

Development Environment (IDE), the Arduino Uno offers an accessible platform for firmware development, 

empowering developers to implement complex algorithms and functionalities tailored to the project's requirements. 

In essence, the Arduino Uno serves as the backbone of Solar Tracking and IoT Battery Monitoring systems, 

providing the computational power, interfacing capabilities, and flexibility necessary to realize the project's 

objectives effectively. 

 

The Arduino Uno has a total of 14 digital input/output pins and 6 analog input pins. Here's a breakdown of the 

functions and common uses of each pin: 

1. Digital Pins (D0-D13) 

 D0 to D13: These are digital input/output pins. They can be used for reading digital inputs (like switches, 

sensors) or outputting digital signals (like controlling LEDs, relays). 

 D0 (RX) and D1 (TX): These pins are also used for serial communication (UART). RX is for receiving 

data, and TX is for transmitting data. 
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 D2 and D3: These pins support interrupt capability. They can be used to trigger an interrupt routine based 

on a change in state. 

 D3, D5, D6, D9, D10, and D11: These pins support PWM (Pulse Width Modulation), allowing you to 

simulate analog output by varying the duty cycle of the signal. 

 D4 and D7: These pins are not commonly highlighted for specific features but can be used as general-

purpose digital pins. 

 

2. Analog Pins (A0-A5) 

 A0 to A5: These pins are analog input pins. They can read analog voltages from sensors or other devices. 

They can also be used as digital pins (A0 as D14, A1 as D15, and so on). 

    

3. Power and Ground Pins 

 5V and 3.3V: These pins provide regulated power supply at 5 volts and 3.3 volts respectively. 

 GND (Ground): These pins are connected to the ground of the system. 

 

4. Other Pins: 

 RESET: This pin is used to reset the microcontroller. 

 AREF: Stands for Analog Reference. It is used to provide an external reference voltage for the analog 

inputs. 

                  4.2 LDR Light Sensor 
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The LDR (Light Dependent Resistor) light sensor plays a pivotal role in Solar Tracking and IoT Battery Monitoring 

systems with ESP8266, acting as a key component for detecting ambient light changes crucial for solar tracking 

functionality. Functioning on the principle of altering its resistance in response to varying light intensity, the LDR 

provides real-time feedback on environmental illumination levels. Integrated with microcontroller boards like the 

Arduino Uno, the LDR sensor serves as a sensing module, interfacing with analog input pins to convert light 

variations into measurable voltage or resistance changes. This data acquisition enables the microcontroller to 

continually assess the current light conditions, essential for optimizing solar panel orientation to maximize energy 

capture throughout the day. By monitoring the resistance or voltage output from the LDR sensor, the 

microcontroller generates precise control signals necessary for adjusting servo motors responsible for aligning solar 

panels with the sun's position. Furthermore, calibration and optimization processes may be employed to fine-tune 

the sensor's sensitivity and responsiveness, ensuring accurate solar tracking performance. Ultimately, the 

integration of the LDR light sensor enhances the system's capability to dynamically adapt to changing light 

conditions, significantly improving energy efficiency and overall performance in solar energy harvesting 

applications. 

4.3 Servo Motor   

                                                                                                        

 

 

 

 

 

 

 

 The servo motor serves as a crucial component within Solar Tracking and IoT Battery Monitoring 

systems, particularly in the context of adjusting the orientation of solar panels for optimal energy capture. 

Functioning as the mechanical actuator responsible for aligning the panels with the sun's position, the servo motor 

receives control signals from the system's microcontroller, typically an Arduino Uno. These signals, often in the 

form of pulse width modulation (PWM), dictate the precise angle of rotation required to maintain alignment with 

the sun's trajectory throughout the day. In response, the servo motor executes these commands, ensuring the solar 

panels continuously face the sun to maximize energy output. Furthermore, some servo motors feature position 

feedback mechanisms, providing real-time information on their current orientation. This feedback loop enables the 

microcontroller to fine-tune the positioning of the solar panels, compensating for any deviations and optimizing 

energy capture efficiency. With their efficient power consumption, durability, and reliability, servo motors are well-

suited for outdoor applications and can withstand the environmental challenges inherent in solar tracking systems. 

Overall, the servo motor's integral role in facilitating precise and responsive adjustments to solar panel orientation 

contributes significantly to the overall effectiveness and efficiency of Solar Tracking and IoT Battery Monitoring 

systems. 
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 4.4 Solar Board  

 

 

 

 

 

 

 

 

 

 

 

 

 

The solar board, a vital component within Solar Tracking and IoT Battery Monitoring systems with ESP8266, 

stands as the primary mechanism for harnessing solar energy. Employing the photovoltaic effect, it converts 

sunlight into electrical energy through arrays of interconnected solar cells. These panels vary in size, efficiency, 

and capacity, offering flexibility to tailor energy generation to specific project requirements. Integrated within the 

solar tracking system, the solar board dynamically adjusts its orientation to align with the sun's position, optimizing 

energy capture throughout the day. This dynamic alignment enhances overall system efficiency by ensuring 

maximum exposure to sunlight. Furthermore, the electrical output from the solar board serves as the power source 

for the battery monitoring system, charging rechargeable batteries and sustaining the operation of IoT components. 

With their robust construction and weather-resistant design, solar boards withstand various environmental 

conditions, ensuring long-term reliability and performance. Additionally, their scalability allows for easy expansion 

to meet evolving energy demands. While requiring minimal maintenance, periodic cleaning and inspections ensure 

continued efficiency and operation. In essence, the solar board epitomizes the renewable energy ethos of Solar 

Tracking and IoT Battery Monitoring systems, serving as a dependable source of clean energy while facilitating 

efficient system operation and sustainability.  
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4.5 ESP8266 WIFI Module 

  

 

 

 

 

 

 

 

 

 

 

The ESP8266 WiFi module is a crucial component within Solar Tracking and IoT Battery Monitoring systems with 

ESP8266, enabling wireless connectivity and communication capabilities essential for remote monitoring and 

control. Serving as the bridge between the system's sensors, microcontroller, and cloud platforms, the ESP8266 

module facilitates the transmission of data over WiFi networks. Equipped with built-in TCP/IP protocol stack, this 

module offers reliable and secure communication channels, ensuring seamless data exchange between the system's 

components and external servers or cloud platforms. Integrated with the Arduino Uno or other microcontroller 

boards, the ESP8266 module receives sensor data, battery status information, and system alerts, transmitting them 

wirelessly to cloud-based IoT platforms such as ThingSpeak. This enables users to remotely monitor system 

performance, access real-time data, and receive timely notifications via web interfaces or mobile applications. 

Furthermore, the ESP8266 module supports bidirectional communication, allowing users to send control commands 

to the system for adjustments or troubleshooting purposes. With its compact form factor, low power consumption, 

and compatibility with a wide range of microcontroller platforms, the ESP8266 module serves as a versatile and 

cost-effective solution for enabling IoT capabilities in solar tracking and battery monitoring systems. Its integration 

empowers these systems with enhanced connectivity, accessibility, and efficiency, paving the way for smarter and 

more sustainable energy management solutions.  

The ESP8266 WiFi module typically refers to boards like the ESP-01, ESP-12, NodeMCU, and others, which use 

the ESP8266 microcontroller. These boards may have different pin configurations, but I'll provide a general 

overview based on the NodeMCU board, which is widely used.Here's a breakdown of the functions and common 

uses of each pin on a NodeMCU board, which has ESP8266 as its microcontroller: 

 

1. Digital Pins (D0-D8) 

 These pins can be used as digital input/output pins. They are typically used for interfacing with digital sensors, 

controlling LEDs, or any other digital device. 

 D0 and D1 are also used for serial communication (UART) similar to Arduino's RX and TX pins. 

    

2. Analog Pins (A0) 
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 The NodeMCU board typically has one analog input pin, labeled as A0. It can be used to read analog voltages 

from sensors. 

 

3. Power and Ground Pins 

 3V3 and 5V: These pins provide regulated power supply at 3.3 volts and 5 volts, respectively. 

 GND (Ground): These pins are connected to the ground of the system. 

 

4. Special Pins 

 RX and TX: These pins are used for serial communication. RX is the receiving pin, and TX is the transmitting 

pin. 

 GPIO16 (D0): This pin has a special function as the wake-up pin from deep sleep mode. 

 GPIO2 (D4): This pin should be held high during boot to enable the module to boot from the onboard flash 

memory. 

 EN (Enable): This pin is used to enable or disable the module. 

 RST (Reset): This pin is used to reset the microcontroller. 

 

5. Built-in LEDs: 

 NodeMCU boards often come with built-in LEDs connected to specific pins for visual feedback. For example, 

there might be an LED connected to pin D0 (GPIO16). 

 

4.6 Node MCU Microcontroller     

               

                                                               

 

 

 

 

 

 

 

The NodeMCU microcontroller is a pivotal component within Solar Tracking and IoT Battery Monitoring systems 

with ESP8266, offering a versatile platform for integrating wireless communication and control capabilities. Built 

around the ESP8266 WiFi module, the NodeMCU combines the functionality of a microcontroller with built-in 

WiFi connectivity, making it an ideal choice for IoT applications. Its compact size, low cost, and ease of use make 

it well-suited for prototyping and developing IoT solutions. Integrated with sensors, actuators, and other peripherals, 

the NodeMCU facilitates data acquisition, processing, and transmission over WiFi networks. In Solar Tracking 

systems, the NodeMCU can receive inputs from sensors such as light-dependent resistors (LDRs) to dynamically 

adjust the orientation of solar panels for optimal energy capture. Similarly, in IoT Battery Monitoring systems, it 
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can monitor battery parameters such as voltage, current, and temperature, transmitting this data to cloud platforms 

for remote monitoring and analysis. The NodeMCU's compatibility with the Arduino IDE simplifies firmware 

development, allowing developers to leverage existing libraries and code examples to expedite project 

implementation. Additionally, its support for Lua scripting enables rapid prototyping and iteration of IoT 

applications. With its robust features, including GPIO pins, analog-to-digital converters (ADCs), and serial 

communication interfaces, the NodeMCU offers flexibility and scalability for a wide range of IoT projects. Overall, 

the NodeMCU microcontroller empowers Solar Tracking and IoT Battery Monitoring systems with ESP8266, 

enabling efficient, reliable, and connected energy management solutions. 

 

4.7 Lithium-ion Battery 

 

 

 

 

 

 

 

 

 

 

Lithium-ion batteries play a critical role in Solar Tracking and IoT Battery Monitoring systems with ESP8266, 

serving as the primary energy storage solution to ensure uninterrupted operation and reliable performance. 

Renowned for their high energy density, lightweight construction, and rechargeable capabilities, lithium-ion 

batteries are ideally suited for mobile and remote applications where space and weight considerations are 

paramount. Within these systems, lithium-ion batteries store the energy harvested from solar panels during periods 

of sunlight abundance, providing a stable power source for continuous operation, even during periods of low or no 

sunlight. This stored energy is essential for powering the various components of the system, including 

microcontrollers, sensors, and wireless communication modules like the ESP8266. Moreover, lithium-ion batteries 

offer fast charging capabilities and exhibit minimal self-discharge rates, ensuring efficient energy utilization and 

prolonged battery life. Additionally, their high cycle life and robust performance characteristics make them well-

suited for long-term deployment in outdoor environments, where they must withstand temperature variations, 

humidity, and other environmental factors. Integrating lithium-ion batteries into Solar Tracking and IoT Battery 

Monitoring systems enhances their reliability, efficiency, and autonomy, enabling them to operate autonomously 

while providing users with real-time insights into energy usage and system performance. Overall, lithium-ion 

batteries are indispensable components in these systems, enabling the storage and utilization of solar energy to 

power IoT applications and ensure sustainable energy management.  
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4.8 Volt Meter & Amp Meter 

 

 

 

 

 

 

 

 

 

 

Voltmeters and ammeters are indispensable components within Solar Tracking and IoT Battery Monitoring systems 

with ESP8266, providing essential measurements of voltage and current to ensure efficient energy management 

and system operation. Voltmeters measure the electrical potential difference, or voltage, across various components 

within the system, including solar panels, batteries, and circuits. This information is crucial for monitoring the 

performance of these components and optimizing energy capture and utilization. By measuring voltage levels, volt 

meters help ensure that solar panels are generating the expected voltage output and that batteries are charging and 

discharging within safe voltage ranges. Ammeters, on the other hand, measure the flow of electrical current through 

the system, providing insights into power consumption, battery charging/discharging rates, and overall system 

efficiency. By monitoring current levels, ammeters enable users to assess energy usage patterns, detect anomalies 

or malfunctions, and optimize system configurations for maximum energy efficiency. Integrated with 

microcontrollers such as the Arduino Uno or NodeMCU, volt meters and ammeters facilitate real-time data 

acquisition and transmission, enabling remote monitoring and control of the system via WiFi connectivity. This 

allows users to access critical information about voltage, current, and power levels from anywhere, facilitating 

proactive maintenance and troubleshooting. With their compact size, accuracy, and compatibility with ESP8266 

modules, volt meters and ammeters play a vital role in ensuring the reliability, efficiency, and performance of Solar 

Tracking and IoT Battery Monitoring systems.  
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4.9 Breadboard                                                                                                           

  

 

 

 

 

 

 

 

 

 

Breadboards are fundamental components in the development and prototyping of electronic circuits, including Solar 

Tracking and IoT Battery Monitoring systems with ESP8266. These versatile tools provide a convenient platform 

for quickly and securely assembling electronic circuits without the need for soldering. Within such systems, 

breadboards serve as the foundation upon which various components, including microcontrollers, sensors, resistors, 

capacitors, and wires, are interconnected to create functional circuits. Their modular design consists of a grid of 

interconnected metal clips housed within an insulating base, allowing components to be easily inserted and 

connected by simply inserting their leads into the appropriate holes. This flexibility enables rapid experimentation 

and iteration during the design and testing phases, facilitating the exploration of different circuit configurations and 

component placements. Additionally, breadboards offer excellent visibility and accessibility, allowing developers 

to easily inspect and troubleshoot circuits by visually tracing connections and making adjustments as needed. 

Integrated with microcontrollers such as the Arduino Uno or NodeMCU, breadboards streamline the prototyping 

process, enabling developers to quickly implement and test new ideas and functionalities. Moreover, their reusable 

nature makes them cost-effective solutions for iterative design processes and educational purposes. Overall, 

breadboards play a crucial role in the development and refinement of Solar Tracking and IoT Battery Monitoring 

systems, providing a versatile and accessible platform for creating and testing electronic circuits. 
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 4.10 Resistors 10k     

 

 

                                                                                                                              

 

 

 

 

 

 

 

 

 

Within Solar Tracking and IoT Battery Monitoring systems with ESP8266, 10k ohm resistors serve as indispensable 

components, crucial for various aspects of circuit design and functionality. These resistors play a multifaceted role, 

aiding in voltage division, current limiting, signal stabilization, and biasing within electronic circuits. Their primary 

function often involves voltage division, where they are employed alongside other resistors to scale down voltages 

for sensor inputs or establish reference voltages. Additionally, 10k ohm resistors serve as pull-up or pull-down 

resistors in digital circuits, ensuring signal stability and preventing floating inputs. They also contribute to current 

limiting, safeguarding components from potential damage due to excessive current flow. Moreover, in certain 

sensor applications, 10k ohm resistors are utilized for biasing purposes, establishing the operating point of the 

sensor or setting reference voltages. Their compatibility with various sensors, microcontrollers, and other electronic 

components, coupled with their reliability and ease of integration, make them indispensable for achieving accurate 

sensor readings, ensuring signal integrity, and safeguarding circuit components. In essence, 10k ohm resistors are 

versatile and essential elements that play a vital role in enabling the efficient operation and functionality of Solar 

Tracking and IoT Battery Monitoring systems. 
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4.8 Battery level indicator           

                              

 

 

 

 

 

 

 

 

 

 

 

 

           A battery level indicator is a crucial feature within Solar Tracking and IoT Battery Monitoring systems with 

ESP8266, providing real-time feedback on the charge level of the battery bank. This indicator typically comprises 

a visual display, such as LED indicators or a digital display, which conveys the current state of the battery's charge. 

The indicator offers valuable insights into the available energy reserves, allowing users to assess the system's power 

status at a glance.Incorporating a battery level indicator enables users to monitor the health and performance of the 

battery bank, ensuring that it remains adequately charged for continuous system operation. By displaying the 

battery's charge level in real-time, users can take proactive measures to recharge the battery when necessary, 

preventing unexpected power outages and downtime.Furthermore, the battery level indicator enhances system 

efficiency by optimizing energy management. Users can adjust energy consumption or implement energy-saving 

measures based on the battery's charge level, thereby prolonging battery life and maximizing overall system 

reliability.Integrated with microcontrollers like the Arduino Uno or NodeMCU, the battery level indicator receives 

data from battery monitoring sensors and translates it into a user-friendly display format. This allows users to access 

critical information about the battery's charge status remotely, facilitating proactive maintenance and 

troubleshooting. 
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4.12 Thinkspeek Platform                                                                                           

 

 

 

 

 

 

 

 

 

 

 

 

 

The ThingSpeak platform, developed by MathWorks, stands as a cornerstone in the realm of Internet of Things 

(IoT) applications, offering a comprehensive solution for collecting, analyzing, and visualizing data from a 

multitude of IoT devices and sensors. Specifically within Solar Tracking and IoT Battery Monitoring systems 

featuring ESP8266 modules, ThingSpeak plays a pivotal role in enabling remote monitoring and management of 

crucial system parameters. Through its intuitive interface, ThingSpeak facilitates the seamless integration of 

ESP8266 modules, allowing for the real-time streaming of data to cloud-based channels. Once collected, this data 

undergoes robust analysis using ThingSpeak's powerful analytics tools, including customizable MATLAB scripts 

and built-in functions, enabling users to gain valuable insights into system performance and energy utilization 

patterns. Moreover, ThingSpeak offers a diverse array of visualization options, ranging from line charts to 

heatmaps, empowering users to interpret data quickly and effectively. Beyond data analysis, ThingSpeak's RESTful 

API enables seamless integration with external services, facilitating automation and remote control based on 

predefined conditions. With its user-friendly interface, robust analytics capabilities, and seamless integration with 

ESP8266 modules, ThingSpeak serves as a versatile and indispensable platform for Solar Tracking and IoT Battery 

Monitoring systems, offering enhanced efficiency, reliability, and control. 

 

4.13 OLED Display 
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The SSD1306 is a popular OLED (Organic Light Emitting Diode) display controller that is commonly used with 

microcontrollers like Arduino. It allows you to easily interface with OLED displays, which are known for their high 

contrast, low power consumption, and wide viewing angles. In the realm of renewable energy, solar power stands 

out as a promising source of clean and sustainable electricity. However, optimizing solar panel efficiency is crucial 

for maximizing energy generation. One effective method to enhance efficiency is through solar tracking systems, 

which adjust the orientation of solar panels to align with the sun's position throughout the day.In this project, we 

combine the power of Arduino microcontrollers with IoT technology to create a solar tracking system. The system 

utilizes an Arduino board, alongside sensors and actuators, to dynamically adjust the position of solar panels for 

optimal sunlight exposure. Additionally, we integrate an ESP8266 module for IoT-based battery monitoring, 

enabling users to remotely monitor the system's battery status.One of the key features of our project is the inclusion 

of an OLED display. This display provides real-time information such as temperature readings, DHT11 sensor 

values, battery voltage, and battery percentage. By presenting this data in a user-friendly format, users can easily 

monitor the system's performance and make informed decisions regarding maintenance or adjustments.In the 

following sections, we will delve into the details of our solar tracking system, including the hardware setup, 

software implementation, and integration of IoT-based battery monitoring. We will also discuss the benefits of 

utilizing OLED displays for real-time data visualization in renewable energy systems. 

4.14 DHT11 

 

 

 

 

 

 

 

 

 

 

The DHT11 sensor epitomizes a foundational cornerstone within the realm of environmental sensing, offering an 

affordable yet robust solution for measuring temperature and humidity levels with remarkable accuracy. Its intrinsic 

design incorporates a sophisticated digital sensor, meticulously calibrated to provide precise readings while 

maintaining an unparalleled level of simplicity in operation.At the heart of the DHT11's functionality lies its innate 

ability to seamlessly communicate digital data via a single-wire interface, rendering it exceptionally user-friendly 

and adaptable across a myriad of electronic projects. This inherent versatility has propelled the DHT11 into the 

spotlight, positioning it as a staple component in various domains ranging from meteorology and climate research 

to smart home automation and industrial monitoring systems.The allure of the DHT11 extends beyond its technical 

prowess, as it embodies a perfect synergy of reliability, affordability, and accessibility. Its compact form factor 

belies its capability, making it an ideal choice for applications where space constraints and power efficiency are 

paramount considerations. Furthermore, its compatibility with popular microcontroller platforms, such as Arduino 
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and ESP8266, further enhances its appeal, opening doors to a vast ecosystem of development tools and resources.In 

the hands of enthusiasts, hobbyists, and professionals alike, the DHT11 sensor serves as a conduit for capturing 

vital environmental data, enabling informed decision-making and facilitating the implementation of proactive 

measures to address changing conditions. Whether deployed in weather monitoring stations, indoor climate control 

systems, or agricultural automation setups, the DHT11 continues to exemplify the pinnacle of reliability and 

performance in temperature and humidity sensing technology. 

 

CHAPTER 5: SOFTWARE IMPLEMEMTATION 

 

 

Arduino 1.0.6 software tools used to program microcontroller. The working of software tool is explained below in 

detail. 

Programming Microcontroller  

A compiler for an abnormal state dialect decreases generation time. To program the Arduino UNO microcontroller 

the Arduino is utilized. The writing computer programs is done entirely in the installed C dialect. Arduino is a suite 

of executable, open source programming advancement devices for the microcontrollers facilitated on the Windows 

stage.  

Arduino is a device for appearing well and good and control a greater amount of the physical world than your 

desktop PC. It's an open-source physical registering stage in view of a straightforward microcontroller board, and 

an improvement domain for composing programming for the board.  

One of the challenges of programming microcontrollers is the restricted measure of assets the developer needs to 

manage. In PCs assets, for example, RAM and preparing speed are essentially boundless when contrasted with 

microcontrollers. Conversely, the code on microcontrollers ought to be as low on assets as could reasonably be 

expected 

About Arduino Compiler 

Get an Arduino board and USB cable 

You additionally require a standard USB link (An attachment to B plug): the kind you would associate with a USB 

printer, for instance. (For the Arduino Nano, you'll require an A to Mini-B link.) 
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Connect the board 

                             The Arduino Uno, Mega, Duemilanove and Arduino Nano consequently draw control 

from either the USB association with the PC or an outer power supply. In case you're utilizing an Arduino Diecimila, 

you'll have to ensure that the board is conFigureured to draw control from the USB association. The power source 

is chosen with a jumper, a little bit of plastic that fits onto two of the three sticks between the USB and power jacks. 

Watch that it's on the two sticks nearest to the USB port. Associate the Arduino board to your PC utilizing the USB 

link. The green power LED (named PWR) ought to go on. 

 

 

 

 

 

 

 

 

 

 

 

 

Writing Sketches 

Software written using Arduino are called sketches. These sketches are written in the text editor. Sketches are saved 

with the file extension .ino. It has features for cutting/pasting and for searching/replacing text. The message area 

gives feedback while saving and exporting and also displays errors. The console displays text output by the Arduino 

environment including complete error messages and other information. The bottom right hand corner of the window 

displays the current board and serial port. The toolbar buttons allow you to verify and upload programs, create, 

open, and save sketches, and open the serial monitor. 

NB: Versions of the IDE prior to 1.0 saved sketches with the extension .pde. It is possible to open these files with 

version 1.0, you will be prompted to save the sketch with the .ino extension on save. 

 

Check  

Checks your code for mistakes.  

 

Transfer  

Assembles your code and transfers it to the Arduino I/O board. See transferring beneath for subtle 

elements.  

Note: If you are utilizing an outer software engineer, you can hold down the "move" key on your PC 

when utilizing this symbol. The content will change to "Transfer utilizing Programmer" 

 

New  

Makes another draw. 
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Open  

Presents a menu of all the representations in your sketchbook. Clicking one will open it inside the present 

window.  

Note: because of a bug in Java, this menu doesn't scroll; on the off chance that you have to open a portray 

late in the rundown, utilize the File | Sketchbook menu. 

 

Spare  

Recoveries your outline.  

 

Serial Monitor ,Opens the serial screen.. 

Table 5.1: Writing Sketches 

 

Extra charges are found inside the five menus: File, Edit, Sketch, Tools, Help. The menus are setting delicate which 

implies just those things applicable to the work as of now being done are accessible. 

Select your serial port 

Select the serial gadget of the Arduino board from the Tools | Serial Port menu. This is probably going to be COM3 

or higher (COM1and COM2 are typically saved for equipment serial ports). To discover, you can disengage your 

Arduino board and re-open the menu; the section that vanishes ought to be the Arduino board. Reconnect the board 

and select that serial port. 

Upload the program 

Before transferring your portray, you have to choose the right things from the Tools > Board and Tools > Serial 

Portmenus. The sheets are depicted beneath. On the Mac, the serial port is most likely something 

like/dev/tty.usbmodem241 On Windows, it's presumably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to discover, you search for USB serial gadget in the ports segment of the 

Windows Device Manager. On Linux, it ought to be/dev/ttyUSB0,/dev/ttyUSB1 or comparable.  

Once you've chosen the right serial port and board, press the transfer catch in the toolbar or select the Upload thing 

from the File menu. Current Arduino sheets will reset naturally and start the transfer. With more established sheets 

(pre-Diecimila) that need auto-reset, you'll have to press the reset catch on the board just before beginning the 

transfer. On most sheets, you'll see the RX and TX LEDs flicker as the portray is transferred. The Arduino condition 

will show a message when the transfer is finished, or demonstrate a blunder. When you transfer a portray, you're 

utilizing the Arduino boot loader, a little program that has been stacked on to the microcontroller on your board. It 

enables you to transfer code without utilizing any extra equipment. The boot loader is dynamic for a couple of 

moments when the board resets; at that point it begins whichever outline was most as of late transferred to the 

microcontroller. The boot loader will squint the on-board (stick 13) LED when it begins (i.e. at the point when the 

board resets).      

Presently, just tap the "Transfer" catch in the earth. Hold up a couple of moments - you should see the RX and TX 

leds on the board blazing. In the event that the transfer is fruitful, the message "Done transferring." will show up in 

the status bar. (Note: If you have an Arduino Mini, NG, or other board, you'll have to physically exhibit the reset 
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catch on the board promptly before squeezing the transfer catch.) 

 

 

 

                                         Figure 5.6: Compilation under Process 

 

A couple of moments after the transfer completes, you should see the stick 13 (L) LED on the board begin to flicker 

(in orange). In the event that it does, congrats! You've gotten Arduino up-and-running. 

 

To upload code to an Arduino Uno using the Arduino IDE, follow these steps: 

 

1. Install Arduino IDE: If you haven't already, download and install the Arduino IDE from the official Arduino 

website (https://www.arduino.cc/en/software). 

 

2. Connect Arduino Uno: Connect your Arduino Uno board to your computer using a USB cable. 

 

3. Open Arduino IDE: Launch the Arduino IDE application. 

 

4. Select Board: Go to the "Tools" menu, then "Board", and select "Arduino Uno" from the list of available boards.  

 

5. Select Port: In the same "Tools" menu, navigate to "Port" and select the port to which your Arduino Uno is 

connected. The port number may vary depending on your operating system. 

 

6. Write or Open Code: Write your code in the Arduino IDE's editor window, or open an existing sketch from the 

"File" menu. 

 

7. Verify/Compile Code: Click the checkmark icon (or go to "Sketch" > "Verify/Compile") to compile your code. 

This step checks for any errors in your code. 

 

8. Upload Code: Once your code compiles successfully, click the right-arrow icon (or go to "Sketch" > "Upload") 

to upload the code to your Arduino Uno.  

 

9. Wait for Upload: The Arduino IDE will compile your code again and then start uploading it to the Arduino Uno. 

During this process, you'll see a message at the bottom of the IDE indicating the progress.  
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10. Upload Complete: Once the upload is complete, you should see a "Done uploading" message in the status bar. 

Your code is now running on the Arduino Uno. 

 

That's it! You have successfully uploaded code to your Arduino Uno using the Arduino IDE. You can now 

disconnect the Arduino Uno from your computer and test your project. 

 

Setting up Thingspeak 

 

Setting up ThingSpeak for IoT-based data logging and visualization is a straightforward process. ThingSpeak is an 

IoT platform that allows you to collect, analyze, and visualize sensor data in real-time. Here's a step-by-step guide 

to setting up ThingSpeak: 

 

1. Create a ThingSpeak Account: 

   Go to the ThingSpeak website (thingspeak.com) and sign up for a free account. If you already have an account, 

simply log in. 

 

2. Create a Channel: 

   Once logged in, navigate to the Channels tab and click on "New Channel" to create a new channel. You will need 

to provide some basic information about your channel, such as a name, description, and field labels. 

 

3. Configure Channel Fields: 

   Specify the number of fields you need for your data. Each field represents a different type of data you want to 

collect. You can give each field a name and choose its data type (e.g., numeric, string, etc.). 

 

4. Set Up API Keys: 

   After creating your channel, go to the API Keys tab to generate API keys. You will need these keys to send data 

to your channel from your IoT device. ThingSpeak supports both read and write API keys, so you can control who 

can access your data. 

5. Connect Your Device: 

   Configure your IoT device to send data to ThingSpeak using the provided API keys. This typically involves 

writing code to send HTTP requests to ThingSpeak's API endpoints with your data payload. 

6. Send Data to ThingSpeak: 

   Once your device is configured, it will start sending data to your ThingSpeak channel. You can view the incoming 

data in real-time on your ThingSpeak channel page. 
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7. Set Up Visualization: 

   ThingSpeak offers various visualization options, including charts, gauges, and maps, to help you analyze your 

data. You can customize your channel's visualization settings to display your data in the most meaningful way. 

 

8. Explore Additional Features: 

   ThingSpeak offers additional features such as MATLAB analysis, triggers, and MATLAB visualizations for 

advanced data processing and analysis. Explore these features to take full advantage of the platform. 

 

To program an ESP8266 using the Arduino IDE, follow these steps: 

 

1. Install the ESP8266 Board Package: 

   - Open the Arduino IDE. 

   - Go to File > Preferences. 

   - In the Additional Board Manager URLs field, add the following URL: 

`http://arduino.esp8266.com/stable/package_esp8266com_index.json` 

   - Click OK to close the Preferences window. 

   - Go to Tools > Board > Boards Manager. 

   - Search for "esp8266" and install the "esp8266" package by ESP8266 Community. 

   - Close the Boards Manager. 

 

2. Select the ESP8266 Board: 

   - Go to Tools > Board and select the appropriate ESP8266 board that you are using. For example, NodeMCU 1.0 

(ESP-12E Module). 

 

3. Set up the COM Port: 

   - Go to Tools > Port and select the COM port to which your ESP8266 is connected. 

 

4. Write Your Code: 

   - Write your Arduino sketch in the IDE. 

 

5. Upload Your Code: 

   - Connect your ESP8266 board to your computer via USB. 

   - Click the Upload button (right arrow icon) in the Arduino IDE to compile and upload your sketch to the 

ESP8266. 

   - Wait for the IDE to compile and upload the sketch to the board. The status messages in the bottom console will 

indicate if the upload was successful. 
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6. Monitor Serial Output (Optional): 

   - If your sketch includes Serial.print() statements for debugging, you can monitor the serial output of the ESP8266 

by opening the Serial Monitor in the Arduino IDE (Tools > Serial Monitor). 

 

That's it! Your code should now be running on the ESP8266 board. You can disconnect the board from your 

computer and power it with an external power source if needed. Remember to select the correct board and COM 

port each time you upload a sketch to the ESP8266. 

 

By following these steps, you can set up ThingSpeak to collect, analyze, and visualize sensor data from your IoT 

devices in real-time. 

 

 

 

 

 

 

 

 

Then go to the API section of the dashboard and copy the API Key. This API key is needed in the code part. 
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IoT Based Battery Monitoring System using ESP8266 on Thingspeak 

 

Open the Serial Monitor after uploading the code. The ESP8266 will try connecting to the WiFi Network. Once it 

connects to the WiFi Network, it will display the Analog Value along with Battery Voltage & Percentage. 

Then go to the private view of Thingspeak Dashboard. The Battery Voltage and Battery Percentage will fill the 

graph. The graph will rise up when the device is charging and will go down when it’s discharging. 
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CHAPTER 6: ADVANTAGES AND APPLICATIONS 

 

6.1 Advantages 

 

1. Enhanced energy capture efficiency through solar tracking. 

2. Real-time monitoring of battery health parameters. 

3. Remote accessibility for monitoring and control. 

4. Insights and analysis capabilities for energy data. 

5. Contribution to sustainable energy management practices. 

6. Increased reliability and uptime of solar power systems. 

7. Optimal utilization of available sunlight throughout the day. 

8. Proactive maintenance through early detection of battery issues. 

9. Reduction of electricity costs and reliance on grid power. 

10. Integration with smart home or building automation systems for seamless    operation. 

 

6.2 Applications 

 

1. Residential solar power systems. 

2. Commercial and industrial installations. 

3. Agricultural and rural applications. 

4. Off-grid and remote locations. 

5. Research and educational institutions. 

6. Microgrid systems for community or neighborhood energy distribution. 

7. Mobile and portable solar-powered devices for outdoor activities. 

8. Emergency response and disaster recovery operations. 

9. Electric vehicle charging stations powered by solar energy. 

10. Sustainable development projects in remote or underserved areas. 
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CHAPTER 7: EXPERIMENTAL RESULT 

The required components are given below. 

 Arduino UNO board x 1  

 Solar panel x 1 

 SG90 servo motor x 1  

 LDR sensor x 2  

 10k resistor x 2  

 Jumper wires x 

 Rigifoam / Foam board / Cardboard 

 

Step 1 

Firstly, identify these components.  
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Step 2: Secondly, cut the base part of the project. To do this, use the following sizes. 

 

 

 

 

 

 

Step 3 

Thirdly, attach the following pieces to the base part. 

 

 

 

 

 

Step 4 

Then, attach the servo motor. For that, use the pictures below. 

 

 

 

Step 5 

Next, attach two pieces of rigifoam to the solar panel. After, attach an iron stick to one side of the solar panel. 
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Step 6 

Now, connect one side of it to the servo motor and the other side to the rigifoam piece.  

 

 

 

 

Step 7 

Then, solder the 10k resistor to one leg of the LDR. Also, solder this way for both sensors. 

 

 

 

Step 8 

Next, solder these sensors together. For that, use the circuit diagram below 
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Step 9 

Afterward, solder the two jumper wires to the voltage divider points of these sensors. Please look at the circuit 

diagram above. 

 

 

 

 

Step 10 

Now, solder the 5v and GND jumper wires. 
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Step 11:  Then, connect these sensors to both sides of the solar panel. 

 

 

 

 

                   Step 12: 

Next, mount the Arduino board and connect the LDR sensors and servo motor to it. You can use the circuit diagram 

above for that. 

 

 

 

 

Step 13 

Now, connect this project to your computer and upload the following program. It is as follows. 
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IoT Based Battery Status Monitoring System using ESP8266: 
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Voltage Divider Calculations 

The maximum battery voltage is 4.2V and the cut-off voltage is 2.8V. Any values lesser than 3.3V will be easily 

supported by the ESP8266 analog pin (A0). 

We have to first step down the upper voltage level for taking the analog value. The maximum battery voltage is 

4.2V and there is a pair of 100KΩ resistors in series with the battery. This will give an output of 2.1V. Similarly, 

the minimum voltage is 2.8V as a cut-off voltage which steps down to 1.4V using the same voltage divider network. 

Now, both the upper and lower voltage is supported by the ESP8266 Analog pin. 

 

 

 

 

   Formula: 

    Vout=Vin×[R2 / (R1+R2)] 
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                 Step 1: Firstly, identify these components. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                  Step 2:Secondly, connect the Nodemcu board to the breadboard. 

 

 

 

 

 

 

 

 

Step 3: Thirdly, connect the bulb holders to the relay module. For that, use the circuit diagram below. 
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                            Step 4: Next, connect the plug top to the 230VAC input point. 

 

 

 

 

 

 

 

 

 

Step 5 

OK, now connect the relay module to the Nodemcu board using the jumper wires. For that, use the circuit diagram 

above. Next, connect it to the computer. 
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Step 6 

Now, let’s set up the Blynk web application step by step. For that, follow the instructions below. 

 First, go to the Blynk official website using your browser. Then login to this site using your email and 

password. (If you don’t have a Blynk account, you must make a new account. For that, use this link. It will guide 

you)   

 Next, click the template button and create a new template . For that, name it as you like. Also, select the 

hardware as ESP8266 and the connection as WIFI 
 Then, click the “Datastreams” tab and create two Datastreams as VitualPin. Also, set the first pin and the second 

pin to V0 and V1. Then, select the data type as an integer. 

 

 Now, click on the Web Dashboard tab. Then, drag and drop two buttons to the dashboard. Next, click the 

setting icon in the button and select the datastream we created earlier. That is, V0 for button one and V1 for button 

two. Finally click the save button. 

 

 Next, click the Search Icon button. After, click the New Devices button and after click the “From template” 

button. Finally, select the template we created earlier. 

 

OK, the Blynk web application is ready for us. 

Step 7:OK, now let’s create the program for this project. It’s as follows. 

 Full details of this project – Download 

 Blynk library — Download 

 WIFI library — Download 

  

/*New Blynk app with Smart Automation 

   Home Page 

*/ 

 

//Include the library files 

#define BLYNK_PRINT Serial 

#include <ESP8266WiFi.h> 

#include <BlynkSimpleEsp8266.h> 
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//Define the relay pins 

#define relay1 D0 

#define relay2 D1 

 

#define BLYNK_AUTH_TOKEN "" //Enter your blynk auth token 

 

char auth[] = BLYNK_AUTH_TOKEN; 

char ssid[] = "";//Enter your WIFI name 

char pass[] = "";//Enter your WIFI password 

 

//Get the button values 

BLYNK_WRITE(V0) { 

  bool value1 = param.asInt(); 

  // Check these values and turn the relay1 ON and OFF 

  if (value1 == 1) { 

    digitalWrite(relay1, LOW); 

  } else { 

    digitalWrite(relay1, HIGH); 

  } 

} 

 

//Get the button values 

BLYNK_WRITE(V1) { 

  bool value2 = param.asInt(); 

  // Check these values and turn the relay2 ON and OFF 

  if (value2 == 1) { 

    digitalWrite(relay2, LOW); 

  } else { 

    digitalWrite(relay2, HIGH); 

  } 

} 

 

void setup() { 

  //Set the relay pins as output pins 

  pinMode(relay1, OUTPUT); 

  pinMode(relay2, OUTPUT); 

 

  // Turn OFF the relay 

  digitalWrite(relay1, HIGH); 

  digitalWrite(relay2, HIGH); 

 

  //Initialize the Blynk library 

  Blynk.begin(auth, ssid, pass, "blynk.cloud", 80); 

} 

 

void loop() { 

  //Run the Blynk library 

  Blynk.run(); 

} 

 Now, copy and paste the Blynk auth token. To do this, check the “Device Info” tab of your Blynk web 

application. 

 Next, enter your correct WIFI name and password. 

 

 Now, select the board and port. Then, upload this program to the Nodemcu board. (If you haven’t yet 

installed the ESP8266 boards, please use this link and follow the instructions) 
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Step 8 

OK, now let’s set up the Blynk mobile dashboard. For that, follow the instructions below. 

 First, download and install the Blynk app on your phone. Then, run this application. Now, you can see 

the template we created ealiar. Next, click this template and set up your dashboard. 

 

 
 

 Now, click the upper right corner button and include the two buttons to the dashboard. Then, arrange 

these widgets as you like. 

 
 Next, click the buttons one by one and select the detastreams V0 and V1 respectively. Also, select the 

mode as switch. 
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OK, the Blynk app is ready. 

Step 9 

Now, connect the 5 VDC external power supply to the Nodemcu board. For that, use the circuit diagram above. 

 

Step 10 

Finally, put the bulbs to the holders and connect the plug top to the AC voltage. (If you have no knowledge of 

this AC voltage, please seek the assistance of an adult) 

 

 

 

 

 

 

 

 

OK, now you can operate these relays using the web or mobile dashboard. The full video guide is below. So, see 

you in the next project. 
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CHAPTER 8: CODE EXPLAINATION 

SOLAR TRACKING SYSTEM WITH ARDUNIO: 

 

MAIN CODE: 

 

//Solar tracking system with ardunio 

 

//Include the servo motor library #include <Servo.h> 

//Define the LDR sensor pins #define LDR1 A0 

#define LDR2 A1 

//Define the error value. You can change it as you like #define error 10 

//Starting point of the servo motor int Spoint = 90; 

//Create an object for the servo motor Servo servo; 

 

void setup() { 

//Include servo motor PWM pin servo.attach(11); 

//Set the starting point of the servo servo.write(Spoint); 

delay(1000); 

} 

 

void loop() { 

//Get the LDR sensor value int ldr1 = analogRead(LDR1); 

//Get the LDR sensor value int ldr2 = analogRead(LDR2); 

 

//Get the difference of these values int value1 = abs(ldr1 - ldr2); 

int value2 = abs(ldr2 - ldr1); 

 

//Check these values using a IF condition 

if ((value1 <= error) || (value2 <= error)) { 

 

} else { 

if (ldr1 > ldr2) { Spoint = --Spoint; 

} 

if (ldr1 < ldr2) { Spoint = ++Spoint; 

} 

} 

//Write values on the servo motor servo.write(Spoint); 

delay(80); 

} 
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CODE EXPLAINATION: 

 

// Include the servo motor library 

#include <Servo.h> 

 

// Define the LDR sensor pins 

#define LDR1 A0 #define LDR2 A1 

 

// Define the error value. You can change it as you like 

#define error 10 

 

// Starting point of the servo motor 

int Spoint = 90; 

 

// Create an object for the servo motor 

Servo servo; 

 

void setup() { 

// Include servo motor PWM pin 

servo.attach(11); 

 

// Set the starting point of the servo 

servo.write(Spoint); 

 

// Delay for stabilization 

delay(1000); 

} 

 

void loop() { 

// Get the LDR sensor value 

int ldr1 = analogRead(LDR1); 

 

// Get the LDR sensor value 

int ldr2 = analogRead(LDR2); 

 

// Get the difference of these values 
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int value1 = abs(ldr1 - ldr2); int value2 = abs(ldr2 - ldr1); 

 

// Check these values using an IF condition 

if ((value1 <= error) || (value2 <= error)) { 

// If difference is within the error margin, do nothing 

} 

else { 

// If difference is beyond the error margin 

if (ldr1 > ldr2) { 

// If ldr1 value is greater, decrement servo position 

Spoint = --Spoint; 

 

} 

if (ldr1 < ldr2) { 

// If ldr2 value is greater, increment servo position 

Spoint = ++Spoint; 

} 

} 

 

// Write the new position to the servo motor 

servo.write(Spoint); 

 

// Delay to allow servo to move 

delay(80); 

} 

 

Explanation: 

 

 The code starts with including the Servo library, which is required to control the servo motor. 

 LDR1 and LDR2 are defined as analog pins A0 and A1 respectively, which are connected to light-

dependent resistors (LDRs). 

  "error" is defined as 10, which sets the acceptable error margin for the difference in LDR readings. 

 "Spoint" is initialized to 90, which represents the starting position of the servo motor. 

  An object "servo" of the Servo class is created. 

 In the setup () function: 

 The servo motor is attached to pin 11. 
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 The starting position of the servo motor is set using servo.write(). 

 There's a delay of 1000 milliseconds for stabilization. 

 In the loop () function: 

 Analog readings from LDR1 and LDR2 are obtained. 

 The absolute difference between the readings is calculated and stored in "value1" and "value2". 

 If the difference is within the acceptable error margin, no action is taken. 

 If the difference exceeds the error margin, the code checks which LDR has a higher value and adjusts the 

servo position accordingly. 

 The servo position is updated using servo.write(). 

 There's a delay of 80 milliseconds to allow the servo to move to the new position. 

 

Used Library 

 Servo Library Inclusion: The code begins by including the Servo library. This library provides functions to control 

servo motors. 

 

 Defining LDR Pins: The pins connected to the Light Dependent Resistors (LDRs) are defined. 

 `LDR1` is connected to pin A0, and `LDR2` is connected to pin A1. 

 

 Error Margin Definition: The acceptable error margin for the difference in LDR readings is defined as `error`. 

This value is set to 10, but it can be adjusted according to the requirements. 

 

 Servo Motor Initialization: The variable `Spoint` is initialized to 90, representing the starting position of the 

servo motor. 

 

 Servo Object Creation: An object `servo` of the `Servo` class is created. 

 

Setup Function: 

 servo.attach(11): attaches the servo motor to pin 11. 

 servo.write(Spoint):  sets the starting position of the servo motor to “Spoint”. 

 delay (1000):  introduces a delay of 1000 milliseconds for stabilization. 

 

 

 

Loop Function: 

 Read the analog values from `LDR1` and `LDR2`. 

 Calculate the absolute difference between the readings and store them in `value1` and `value2`. 

 If the difference between the LDR readings is within the defined error margin, no action is taken. 
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 If the difference exceeds the error margin: 

 Compare the LDR readings: 

   If `ldr1` is greater than `ldr2`, decrement the servo position. 

   If `ldr1` is less than `ldr2`, increment the servo position. 

 Write the new position to the servo motor using `servo.write(Spoint)`. 

 Introduce a delay of 80 milliseconds to allow the servo to move to the new position. 

 

This code essentially implements a solar tracking system using Arduino and a servo motor, where the servo motor 

adjusts its position based on the readings from two LDRs to maximize exposure to sunlight. 

 

IoT Based Battery Status Monitoring System using ESP8266 

#include <Wire.h> 

#include <Adafruit_GFX.h> 

#include <Adafruit_SSD1306.h> 

#include <DHT.h> 

#include <ESP8266WiFi.h> 

 

#define SCREEN_WIDTH 128 

#define SCREEN_HEIGHT 64 

#define OLED_RESET    -1 

#define DHTPIN D4     // Digital pin connected to the DHT sensor 

#define DHTTYPE DHT11 // DHT 11 

 

const char* ssid = "12345678";     // Enter your WiFi Network's SSID 

const char* password = "12345678"; // Enter your WiFi Network's Password 

const char* server = "api.thingspeak.com"; 

String apiKey = "VKH4CYC7UQ8D5EU0"; // Enter your ThingSpeak API Key 

 

DHT dht(DHTPIN, DHTTYPE); 

 

Adafruit_SSD1306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, OLED_RESET); 

 

int analogInPin  = A0;    // Analog input pin 

int sensorValue;          // Analog Output of Sensor 

float calibration = 0.36; // Check Battery voltage using multimeter & add/subtract the value 

int bat_percentage; 

 

WiFiClient client; 

 

void setup() { 

  Serial.begin(115200); 

 

  // Connect to WiFi 

  WiFi.begin(ssid, password); 

  Serial.print("Connecting to WiFi"); 

  while (WiFi.status() != WL_CONNECTED) { 

    delay(500); 

    Serial.print("."); 

  } 

  Serial.println("WiFi connected"); 
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  // Initialize OLED display 

  if(!display.begin(SSD1306_SWITCHCAPVCC, 0x3C)) { 

    Serial.println(F("SSD1306 allocation failed")); 

    for(;;); 

  } 

 

  // Display "EEE DEPARTMENT MAIN PROJECT" on OLED display for 2 seconds 

  display.clearDisplay(); 

  display.setTextSize(1); // Increase text size 

  display.setTextColor(SSD1306_WHITE); 

  display.setCursor(0, 0); // Adjust cursor position 

  display.print(F("EEE DEPARTMENT")); 

  display.setTextSize(1); // Increase text size 

  display.setCursor(0, 25); // Adjust cursor position 

  display.print(F("MAIN PROJECT")); 

  display.display(); 

  delay(5000); // Display for 2 seconds 

 

  // Add additional text for 2 seconds 

  display.clearDisplay(); 

  display.setTextSize(1); // Increase text size 

  display.setTextColor(SSD1306_WHITE); 

  display.setCursor(0, 0); // Adjust cursor position 

  display.print(F("PRESENTED BY ")); 

  display.setTextSize(1); // Increase text size 

  display.setCursor(0, 10); // Adjust cursor position 

  display.print(F("(Batch No.: 03) ")); 

  display.setTextSize(1); // Increase text size 

  display.setCursor(0, 25); // Adjust cursor position 

  display.print(F("Under the Guidance of")); 

  display.setTextSize(1); // Increase text size 

  display.setCursor(0, 40); // Adjust cursor position 

  display.print(F("Dr. M.C.V. Suresh")); 

  display.display(); 

  delay(5000); // Display for 2 seconds 

 

  // Initialize DHT sensor 

  dht.begin(); 

} 

 

void loop() { 

  // Read temperature and humidity from DHT sensor 

  float temperature = dht.readTemperature(); 

  float humidity = dht.readHumidity(); 

 

  // Read battery voltage 

  sensorValue = analogRead(analogInPin); 

  float voltage = (((sensorValue * 3.3) / 1024) * 2 + calibration); //multiply by two as voltage divider network is 

100K & 100K Resistor 

 

  bat_percentage = mapfloat(voltage, 2.8, 4.2, 0, 100); //2.8V as Battery Cut off Voltage & 4.2V as Maximum 

Voltage 

 

  if (bat_percentage >= 100) { 

    bat_percentage = 100; 

  } 
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  if (bat_percentage <= 0) { 

    bat_percentage = 1; 

  } 

 

  // Print temperature, humidity, battery voltage, and battery percentage to Serial Monitor 

  Serial.print("Temperature: "); 

  Serial.print(temperature); 

  Serial.println(" °C"); 

  Serial.print("Humidity: "); 

  Serial.print(humidity); 

  Serial.println(" %"); 

  Serial.print("Battery Voltage: "); 

  Serial.print(voltage); 

  Serial.println(" V"); 

  Serial.print("Battery Percentage: "); 

  Serial.print(bat_percentage); 

  Serial.println(" %"); 

 

  // Display temperature, humidity, battery voltage, and battery percentage on OLED display 

  display.clearDisplay(); 

  display.setTextSize(2); // Increase text size 

  display.setTextColor(SSD1306_WHITE); 

  display.setCursor(0,0); 

  display.print(F("Batch 3")); 

  display.setTextSize(1); // Reset text size 

  display.setCursor(0, 20); // Adjust cursor position 

  display.print(F("Temp: ")); 

  display.print(temperature); 

  display.print(F(" C")); 

  display.setCursor(0, 30); // Adjust cursor position 

  display.print(F("Humidity: ")); 

  display.print(humidity); 

  display.print(F("%")); 

  display.setCursor(0, 40); // Adjust cursor position 

  display.print(F("Battery Voltage: ")); 

  display.print(voltage); 

  display.print(F(" V")); 

  display.setCursor(0, 50); // Adjust cursor position 

  display.print(F("Battery Percentage: ")); 

  display.print(bat_percentage); 

  display.print(F(" %")); 

  display.display(); 

 

  // Send data to ThingSpeak 

  if (client.connect(server, 80)) { 

    String postStr = apiKey; 

    postStr += "&field1="; 

    postStr += String(temperature); // Add temperature value 

    postStr += "&field2="; 

    postStr += String(humidity); // Add humidity value 

    postStr += "&field3="; 

    postStr += String(voltage); // Add battery voltage value 

    postStr += "&field4="; 

    postStr += String(bat_percentage); // Add battery percentage value 

    postStr += "\r\n\r\n"; 

  

    client.print("POST /update HTTP/1.1\n"); 

http://www.jetir.org/


© 2024 JETIR April 2024, Volume 11, Issue 4                                                                  www.jetir.org(ISSN-2349-5162) 

 

JETIRTHE2095 Journal of Emerging Technologies and Innovative Research (JETIR) www.jetir.org 325 
 

    delay(100); 

    client.print("Host: api.thingspeak.com\n"); 

    delay(100); 

    client.print("Connection: close\n"); 

    delay(100); 

    client.print("X-THINGSPEAKAPIKEY: " + apiKey + "\n"); 

    delay(100); 

    client.print("Content-Type: application/x-www-form-urlencoded\n"); 

    delay(100); 

    client.print("Content-Length: "); 

    delay(100); 

    client.print(postStr.length()); 

    delay(100); 

    client.print("\n\n"); 

    delay(100); 

    client.print(postStr); 

    delay(100); 

  } 

  client.stop(); 

  Serial.println("Sending...."); 

  delay(15000); // Delay between sending data to ThingSpeak 

} 

 

float mapfloat(float x, float in_min, float in_max, float out_min, float out_max) { 

  return (x - in_min) * (out_max - out_min) / (in_max - in_min) + out_min; 

} 

 

CODE EXPLANATION: 

 

This Arduino sketch is designed to read analog sensor values, calculate battery voltage and percentage, and then 

send this data to ThingSpeak, an IoT platform, for monitoring purposes. Below is a breakdown of the code: 

 

#include <ESP8266WiFi.h> 

 

// ThingSpeak API Key 

String apiKey = "**************"; 

 

// WiFi credentials 

const char* ssid = "**************"; // Enter your WiFi Network's SSID 

const char* pass = "**************"; // Enter your WiFi Network's Password 

 

// ThingSpeak server address 

const char* server = "api.thingspeak.com"; 

 

// Analog pin for sensor input 

int analogInPin = A0; 
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// Variables to store sensor values and battery percentage 

int sensorValue; 

float calibration = 0.36; // Calibration factor for battery voltage 

int bat_percentage; 

 

// Create a WiFi client object 

WiFiClient client; 

 

void setup() { Serial.begin(115200); Serial.println("Connecting to "); Serial.println(ssid); WiFi.begin(ssid, pass); 

 

// Wait for WiFi connection 

while (WiFi.status() != WL_CONNECTED) { delay(100); 

Serial.print("*"); 

} 

Serial.println(""); Serial.println("WiFi connected"); 

} 

void loop() { 

// Read analog sensor value 

sensorValue = analogRead(analogInPin); 

 

// Convert sensor value to voltage 

float voltage = (((sensorValue * 3.3) / 1024) * 2 + calibration); // Voltage divider network is 100K & 100K 

Resistor 

 

// Map voltage to battery percentage 

bat_percentage = mapfloat(voltage, 2.8, 4.2, 0, 100); // Battery Cut off Voltage: 2.8V, Maximum Voltage: 

4.2V 

 

// Ensure battery percentage is within valid range 

if (bat_percentage >= 100) { bat_percentage = 100; 

} 

if (bat_percentage <= 0) { bat_percentage = 1; 

} 

 

// Print sensor and battery information Serial.print("Analog Value = "); Serial.print(sensorValue); 

Serial.print("\t Output Voltage = "); Serial.print(voltage); 
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Serial.print("\t Battery Percentage = "); Serial.println(bat_percentage); delay(1000); 

 

// Connect to ThingSpeak and send data 

if (client.connect(server, 80)) { String postStr = apiKey; postStr += "&field1="; postStr += String(voltage); postStr 

+= "&field2="; 

postStr += String(bat_percentage); postStr += "\r\n\r\n"; 

 

client.print("POST /update HTTP/1.1\n"); delay(100); 

client.print("Host: api.thingspeak.com\n"); delay(100); 

client.print("Connection: close\n"); delay(100); 

client.print("X-THINGSPEAKAPIKEY: " + apiKey + "\n"); delay(100); 

client.print("Content-Type: application/x-www-form-urlencoded\n"); delay(100); 

client.print("Content-Length: "); 

delay(100); client.print(postStr.length()); delay(100); client.print("\n\n"); delay(100); client.print(postStr); 

delay(100); 

} 

client.stop(); Serial.println("Sending. "); 

delay(15000); // Send data every 15 seconds 

} 

 

// Function to map a float value 

float mapfloat(float x, float in_min, float in_max, float out_min, float out_max) { return (x - in_min) * (out_max - 

out_min) / (in_max - in_min) + out_min; 

} 

 

Explanation: 

 

 The code includes the ESP8266WiFi library to enable WiFi connectivity. 

 WiFi credentials (SSID and password) and the ThingSpeak API key are defined. 

 The server variable holds the address of the ThingSpeak server. 

 An analog pin (A0) is designated for sensor input. 

 sensorValue stores the analog sensor reading, and `calibration` adjusts for any discrepancies. 

 battery percentage calculates the battery percentage based on the analog reading. 

 In the setup() function: 

 Serial communication is initiated. 

 WiFi connection is established. 

 In the  loop()  function: 

 Sensor reading is obtained and converted to voltage. 
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 Voltage is mapped to a battery percentage. 

 Data is sent to ThingSpeak in the specified format. 

 Serial output displays the sensor reading, voltage, and battery percentage. 

 Data transmission occurs every 15 seconds. 

 mapfloat() is a custom function to map a float value from one range to another. 

 

The key elements of this Arduino sketch in terms of libraries, connections, and data sources: 

 

Library Used: 

 

  ESP8266WiFi: This library enables the ESP8266 WiFi module to connect to a wireless network. It provides 

functions to establish a connection to a WiFi network and communicate over the internet. 

Connection: 

 

 WiFi Connection: The sketch connects to a WiFi network using the `WiFi.begin()` function, which takes the 

SSID and password of the network as parameters. It waits for the connection to be established using a `while` loop 

with `WiFi.status()` until `WL_CONNECTED`. 

Data Sources: 

 

 Analog Sensor: The system reads data from an analog sensor connected to pin A0. This sensor could be any 

analog sensor, such as a voltage sensor, temperature sensor, or light sensor. In the provided sketch, the assumption is 

that the sensor measures battery voltage. 

 Battery Voltage: The voltage reading from the analog sensor is used to calculate the battery percentage. This 

voltage reading is the primary data source for determining the battery status. 

 

 ThingSpeak: ThingSpeak is an IoT platform that allows users to collect, visualize, and analyze data from 

sensors or devices. In this sketch, ThingSpeak is the destination for sending the battery voltage and percentage data. 

The ThingSpeak API key and server address are used to establish a connection to the platform. 

 

The sketch utilizes the ESP8266WiFi library to establish a WiFi connection, reads data from an analog sensor 

(assumed to measure battery voltage), and sends this data to the ThingSpeak platform for remote monitoring and 

analysis. The WiFi connection provides internet access for data transmission, and ThingSpeak serves as the data 

repository and visualization platform. 

 

AUTOMATION SYSTEM USING THE NODEMCU ESP8266 BOARD AND  THE NEW BLYNK APP 

MAIN CODE: 
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//Include the library files #define BLYNK_PRINT Serial #include <ESP8266WiFi.h> 

#include <BlynkSimpleEsp8266.h> 

 

//Define the relay pins #define relay1 D0 #define relay2 D1 

#define BLYNK_AUTH_TOKEN "" //Enter your blynk auth token char auth[] = BLYNK_AUTH_TOKEN; 

char ssid[] = "";//Enter your WIFI name char pass[] = "";//Enter your WIFI password 

 

//Get the button values BLYNK_WRITE(V0) { 

bool value1 = param.asInt(); 

// Check these values and turn the relay1 ON and OFF if (value1 == 1) { 

digitalWrite(relay1, LOW); 

} else { 

digitalWrite(relay1, HIGH); 

} 

} 

 

void setup() { 

//Set the relay pins as output pins pinMode(relay1, OUTPUT); pinMode(relay2, OUTPUT); 

 

// Turn OFF the relay digitalWrite(relay1, HIGH); digitalWrite(relay2, HIGH); 

 

//Initialize the Blynk library 

Blynk.begin(auth, ssid, pass, "blynk.cloud", 80); 

} 

       void loop() { 

//Run the Blynk library Blynk.run(); 

} 

 

CODE EXPLAINATION: 

 

// Include the required library files #define BLYNK_PRINT Serial #include <ESP8266WiFi.h> #include 

<BlynkSimpleEsp8266.h> 

// Define the relay pins #define relay1 D0 #define relay2 D1 

#define BLYNK_AUTH_TOKEN "" // Enter your Blynk auth token char auth[] = BLYNK_AUTH_TOKEN; 

char ssid[] = ""; // Enter your WiFi name char pass[] = ""; // Enter your WiFi password 

// Callback function to handle button widget state changes on virtual pin V0 BLYNK_WRITE(V0) { 

bool value1 = param.asInt(); 
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// Check the state of the button and control relay1 accordingly if (value1 == 1) { 

digitalWrite(relay1, LOW); // Turn on relay1 

 

} else { 

 

digitalWrite(relay1, HIGH); // Turn off relay1 

 

} 

 

 

// Callback function to handle button widget state changes on virtual pin V1 BLYNK_WRITE(V1) { 

bool value2 = param.asInt(); 

 

// Check the state of the button and control relay2 accordingly if (value2 == 1) { 

digitalWrite(relay2, LOW); // Turn on relay2 

 

} else { 

 

digitalWrite(relay2, HIGH); // Turn off relay2 

 

} 

 

} 

 

void setup() { 

 

// Set the relay pins as output pins pinMode(relay1, OUTPUT); pinMode(relay2, OUTPUT); 

// Turn off the relays initially digitalWrite(relay1, HIGH); digitalWrite(relay2, HIGH); 

// Initialize the Blynk library with WiFi connection details Blynk.begin(auth, ssid, pass, "blynk.cloud", 80); 

} 

 

 

void loop() { 

 

// Run the Blynk library Blynk.run(); 

 

Explanation: 
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 The code is designed to work with the Blynk app, which is a platform for IoT projects. It's intended for home 

automation, where users can control devices remotely via the Blynk app. 

 

 The code begins by including the necessary libraries, `ESP8266WiFi` and 

 `BlynkSimpleEsp8266`, required for WiFi connectivity and interfacing with the Blynk server. 

 

 Relay pins `relay1` and `relay2` are defined as ‘D0’ and ‘D1’, respectively, assuming they are connected to 

digital pins on the ESP8266. 

 

 `BLYNK_AUTH_TOKEN` is defined as an empty string. Users should replace it with their Blynk 

authentication token obtained from the Blynk app. 

 

 WiFi credentials (`ssid` and `pass`) are provided. Users should replace them with their WiFi network's SSID and 

password. 

 Two callback functions (`BLYNK_WRITE(V0)` and `BLYNK_WRITE(V1)`) are defined to handle changes in 

the state of buttons on virtual pins `V0` and `V1`. These buttons are assumed to be present on the Blynk app's user 

interface. 

 In the `setup()` function: 

 Relay pins are configured as output pins. 

 Initially, the relays are turned off by setting their respective pins to HIGH. 

CHAPTER 9: CONCLUSION AND FUTURE SCOPE 

 

9.1 Conclusion   

In conclusion, the integration of Solar Tracking and IoT Battery Monitoring with ESP8266 on ThingSpeak presents 

a comprehensive solution for optimizing solar energy utilization and enhancing battery management in sustainable 

energy systems. By dynamically adjusting solar panel orientation to maximize energy capture and remotely 

monitoring battery health parameters in real-time, this innovative approach ensures efficient energy production and 

storage. The utilization of the ThingSpeak platform facilitates seamless data collection, analysis, and visualization, 

empowering users with valuable insights into system performance and enabling proactive maintenance strategies. 

Through enhanced reliability, increased efficiency, and remote accessibility, this integrated solution offers 

significant advantages across residential, commercial, industrial, and rural applications, paving the way for a 

greener and more sustainable energy landscape. Moving forward, continued advancements in technology and 

widespread adoption of such integrated systems hold the potential to drive meaningful progress towards achieving 

global energy sustainability goals. Overall, Solar Tracking & IoT Battery Monitoring with ESP8266 on ThingSpeak 

offers a holistic solution for sustainable energy management, contributing to reduced electricity costs, enhanced 

reliability, and minimized environmental impact. With continued advancements in technology and implementation, 

this solution holds promise for widespread adoption across residential, commercial, industrial, and rural 
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applications, ultimately paving the way towards a cleaner and more sustainable energy future.  

               

                                                                                

9.2 Future Scope   

The future scope for Solar Tracking & IoT Battery Monitoring with ESP8266 on ThingSpeak holds immense 

promise, with several avenues for further development and enhancement. Some of the key areas of future 

exploration and advancement include: 

1. Advanced Analytics and Machine Learning Integration: Incorporating advanced analytics techniques, such 

as machine learning algorithms, can further optimize energy management strategies by predicting energy 

production patterns, identifying anomalies, and recommending optimal system configurations. 

 

 

2. Integration with Renewable Energy Sources: Expanding the scope of the system to integrate with other 

renewable energy sources, such as wind or hydroelectric power, can create hybrid energy systems that offer 

enhanced reliability and resilience. 

 

3. Energy Trading and Peer-to-Peer Energy Sharing: Implementing mechanisms for energy trading and peer-

to-peer energy sharing can enable users to buy, sell, or exchange excess energy generated by their solar systems, 

fostering community-based energy initiatives and promoting energy self-sufficiency. 

 

4. Enhanced Remote Control and Automation: Developing advanced remote control and automation features, 

such as predictive maintenance scheduling and adaptive energy management algorithms, can further streamline 

system operation and optimize energy utilization based on changing environmental conditions and user preferences. 

 

5. Integration with Smart Grid Technologies: Integrating Solar Tracking & IoT Battery Monitoring systems with 

smart grid technologies can enable bi-directional communication between energy consumers, producers, and grid 

operators, facilitating dynamic energy pricing, demand response, and grid balancing. 

 

6. Expansion of Application Domains: Exploring new application domains, such as transportation electrification, 

smart cities, and decentralized microgrids, can unlock novel opportunities for deploying Solar Tracking & IoT 

Battery Monitoring systems in diverse contexts, thereby accelerating the transition towards a sustainable energy 

future. 

 

7. Standardization and Interoperability: Establishing industry standards and protocols for interoperability 

between different components and systems can promote compatibility, scalability, and interoperability, facilitating 

seamless integration and deployment of Solar Tracking & IoT Battery Monitoring solutions across diverse 

environments and use cases. 
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8. Cost Reduction and Affordability: Continued research and development efforts aimed at reducing the cost of 

hardware components, improving energy efficiency, and optimizing system design can enhance the affordability 

and accessibility of Solar Tracking & IoT Battery Monitoring solutions, making them more widely accessible to a 

broader range of users. 

 

In essence, the future of Solar Tracking & IoT Battery Monitoring with ESP8266 on ThingSpeak is characterized 

by continuous innovation, collaboration, and adaptation to emerging technological trends and market dynamics. By 

leveraging advancements in analytics, integration, and automation, these systems have the potential to play a pivotal 

role in reshaping the global energy landscape and driving the transition towards a sustainable, decentralized, and 

resilient energy infrastructure.                                                                                                    
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